Avizo 8
3D Analysis Software for Scientific and Industrial data

Dear Avizo User,

With this document we would like to inform you about the most important new features, improvements, and changes in this version. Please carefully read these Release Notes. We would appreciate your feedback regarding this version. If you encounter problems but also if you have suggestions for improvement, please report them to vsghotline@fei.com. We would like to thank you in advance for your efforts.

July 2013, the Avizo and Amira team

CONTENT

Overview....................................................................................................................................................... 2
New products and enhancements in Avizo XLab extensions family................................................................. 3
Avizo all editions - enhancements and new features ...................................................................................... 5
    User Interface enhancements .................................................................................................................. 5
    New and enhanced features ............................................................................................................... 7
    New file formats supported ............................................................................................................... 13
    Performance improvements ..................................................................................................... 13
    Scripting enhancements and new commands ..................................................................................... 13
Avizo Fire edition - enhancements and new features .................................................................................. 15
    New platforms .................................................................................................................................. 15
    New and enhanced features .............................................................................................................. 15
    New file formats supported ............................................................................................................ 22
    Performance improvements ........................................................................................................... 23
Avizo Wind edition – enhancements and new features ............................................................................ 23
Avizo XScreen - enhancements ................................................................................................................ 24
Avizo XPand – update .................................................................................................................................. 24
List of solved issues .................................................................................................................................. 25

Avizo 8.0 release notes – VSG© 2013
Avizo 8 is a major evolution of the Avizo product family including new extensions, enhancements of the user interface for ease of use and simplified workflows, new and enhanced features, and performance improvements.

**Important note**

The Quantification Tools module of Avizo Fire is no longer accessible from menus by default as it is now superseded by a large new set of Avizo modules and components. This major change was achieved to facilitate learning, to improve ease of use and workflows with better user interface consistency. Avizo Fire is now available on Windows, Mac OS and Linux platforms. The Quantification Tools module is still supported for projects and script compatibility on Windows. See below section about Avizo Fire enhancements for more details.

Note also that the new object popup has an integrated search tool that can quickly retrieve modules corresponding to former commands of the Quantification Tools module, or other legacy names.
NEW PRODUCTS AND ENHANCEMENTS IN AVIZO XLAB EXTENSIONS FAMILY

New extension XLab Thermo (Thermal Conductivity)

XLab Thermo, a new extension of Avizo Fire software, provides numerical simulation capabilities to calculate thermal conductivity of a porous medium from a scanned sample (CT, FIB/SEM, MRI, etc.). XLab Thermo directly computes the material’s property from the segmented 3D image. Fourier’s equation is solved using a finite volume method, with no need to extract a 3D mesh. Two new modules are provided with this extension:

- **Thermal Conductivity Tensor Calculation**
  The thermal conductivity tensor is computed using homogenization method applied to Fourier’s equation. The studied sample is considered representative of a larger scale material, thus allowing periodic boundary conditions to be imposed. The thermal conductivity tensor provides additional information about the intensity of thermal conductivity along any direction in space and can reveal anisotropy of the porous media.

- **Thermal Conductivity Experiment Simulation**
  An experiment is simulated by imposing two among the three possible boundary conditions: constant temperature imposed at input face of the sample, constant temperature imposed at output face of the sample, constant thermal flux across the sample. The sample is also closed on the four other faces with thermal insulator to guide the flux along a single direction.

The calculation considers diffusive conductivity, without convection or radiation, of a multi-phase material. Each phase property can be set individually, as insulating or with specified conductivity. See Avizo XLab User’s Guide for more information. XLab Thermo is available on Windows XP/Vista/7/8 64-bit.

New option for XLab Hydro: GPU acceleration

The GPU option for XLab Hydro allows using available Graphics Processing Unit for computation, as an alternative to using CPUs. Data is not required to fit in GPU memory (out-of-core processing). The GPU implementation can dramatically increase the computation speed. For instance, compared to 8 CPU cores, a speedup of a factor 10 may be obtained. If the data cannot be fully contained in GPU memory, the speedup can still be a factor 3.

See Avizo XLab User’s Guide for more information. XLab Hydro is available on Windows XP/Vista/7/8 64-bit. The GPU option requires a separate license in addition to the XLab Hydro license.
Stop and rerun simulations

It is now possible to suspend and resume a simulation. Pressing the Stop button during XLab calculation leaves the last calculated field as result. XLab modules can take an initial field as input to restart simulation. Therefore the result of a previous computation can be reused to restart computation from where it ended. This is useful in particular if computation was stopped before the desired error threshold was reached.
USER INTERFACE ENHANCEMENTS

New Object Popup – a module finder

The new Object Popup is a new component replacing the former object popup menu, used for attaching modules to a specific object. The Object Popup can be accessed by right-clicking on an object in the Project View or by pressing Ctrl-Space if an object is selected. The following features are provided:

- A search engine allows retrieving modules or objects by names without navigating through the categories explorer. A completion popup lists the matching objects and categories, including former objects renamed or deprecated and replaced by new ones. For instance you can search the command name binseparate to retrieve the new corresponding module Separate Objects. The search area has a configuration menu (arrow button on the right side) for selecting the types of items to be searched. It is also possible to extend the search to a full documentation search.

- An explorer allows browsing the categories of object items which can be attached to the object selected in the Project View. The explorer includes Favorites, Recents, Editors, Templates specific categories. The list of favorite and recently used modules is persistent across Avizo sessions.

- A preview panel is used to display an object short description when it is selected in the explorer, add or remove an object in the Favorites category (star icon), create an object or access object help page.

- An Options button (top left) gives access to objects operations - hide, remove, duplicate, rename.

- A Save button allows saving (or saving as) a data to disk.

To create or attach an object, you can double-click the object entry in the explorer or press the Create button in the preview panel.
In the same way as the new Object Popup, the new Create Object Popup menu is a new component replacing the former Create menu, used for creating modules or data objects that cannot be accessed via the Object Popup of any other object. The Create Object popup menu can be accessed by right-click in the Project View or by the top menu Project.

This popup menu looks and works like the new Object Popup within the Project View.

**Moved Graph View and Tree View toolbar buttons**

The Graph View and Tree View buttons are replaced by a toggle button in the Main Panel, next to other Project View buttons.

**New Tables Panel**

The Tables Panel becomes the central place to display all spreadsheets, including Avizo Fire analysis spreadsheets. You can tab, cascade or tile the spreadsheets windows within this panel. Like other panels, the Tables Panel can be detached and docked freely.
Warning dialogs that can be disabled and restored

Some warning dialogs now allow disabling the warning message so it appears only once. You can restore disabled messages boxes through the Preference General panel, Restore Defaults... button.

NEW AND ENHANCED FEATURES

Enhanced Volume Rendering

Avizo 8 uses a new ray-casting volume rendering engine, based on Open Inventor 9 technology for higher quality and performance.

The Volume Rendering Settings has new options:

- Lighting: Deferred. This option defers lighting rendering onto opaque surfaces, saving rendering time and leading to sharper objects boundaries. This works best using a colormap with a steep opacity curve.
• Effects: Ambient Occlusion. This effect is an approximation of global illumination similar to an outdoor environment, that provides better depth perception of 3D objects. This works best combined with deferred lighting and using a colormap with a steep opacity curve.

• Advanced, Composition: Average. This produces a radiography-like effect.

• Advanced, Slice alignment: Boundary. This provides best accuracy with ray-casting rendering (default).

**Note:**

Because of the new enhanced volume rendering engine, it may be needed in some case to adjust the Volume Rendering Settings or the Preferences (LDA) to achieve similar rendering results as previous versions of Avizo.

A number of advanced optimization settings in Volume Rendering Settings are now deprecated and withdrawn. In most cases, setting "Use high precision frame-buffer" in Preferences is no longer needed for volume rendering with highly transparent colormaps. This may still be necessary for rendering multiple volumes at once, or multi-channel volumes.

The rendering of multiple volumes at once has been enhanced, with substantially improved performance.

Support has been extended for graphics cards such as Intel HD 3000 graphics boards. Note however that Intel HD 4000 is not fully supported in the current release.

**New module Voxelized Rendering**

A new module is available for voxelized volume rendering. This is useful in particular to display exact voxel boundaries of a label field or binary image. Best visual effects can be achieved by using ambient occlusion, deferred lighting, optionally with outline.

**Upgraded LDA format**

The new volume rendering engine doesn't require any longer overlapping borders for the tiles stored in LDA files in order to prevent lighting artifacts.
Therefore Avizo 8 LDA format doesn’t support anymore the *border size* option, which has disappeared from the LDA Preferences panel. The recommended tile size preference remains 128. Avizo can still load previous LDA files using border size. However, when loading files using such legacy format, Avizo will propose to upgrade to the new format for loading data with optimal performance. Border-less file format is also required for correct extraction with subsampling using Extract Subvolume.

**Enhanced Animation Producer**

You can now double-click on the time ruler to set the current time, as alternative to moving the time slider. Double-clicking on a timeline creates a new keyframe.

Performance has been improved significantly when playing an animation, animation preview is more consistent with the specified time.

A play speed factor can be set in the time management options (*More options* button). When set, the play speed factor is reminded in the control panel, above the current time.

A number of interpolation curves have been added for transitions between keyframes. Hover on a keyframe to bring the keyframe edit dialog and select a transition curve. The interpolation can be accelerating, decelerating, or halfway. For each item a tooltip provides more details and a graphical representation is displayed. Linear transitions can be defined for components such as menu choices.

Multi-options ports can now be animated.
Animations can now be played on advanced multi-display configurations using Avizo XScreen.

### Enhanced Plot Tool and Histograms

The Plot Tool, used for histograms, curves, etc., has been enhanced as follows:

- Ticks can be optionally displayed on axis boxes.
- Marker line labels can be offset in X and Y.
- Histogram bins are now separated with a definable spacing, as long as the current zoom allows distinguishing individual bins. A border color can also be defined for histogram bins.
- Zooming and panning can be disabled independently on X and Y axis. Zooming and panning along Y axis is disabled by default for histograms.
- X axis is now synchronized with histogram range (port \textit{Range} of module Histogram)
- Histograms are now rendered using a gradient foreground color
- The font for legends can now be changed.
- The y axis scaling can be set as logarithmic or linear by right-click in the histogram display area.

![Enhanced Plot Tool and Histograms](image)

### Enhanced Crop Editor

The Auto-crop threshold is now retrieved from data range calibration or data window if any. The Crop Editor has also new buttons for reducing or enlarging easily the current box. This is typically useful after auto-crop.

The corresponding Tcl command for data objects has been extended:

```tcl
<data> crop [-auto threshold | imin imax jmin jmax kmin kmax [value]] [-enlarge adjustValue] [-reduce adjustValue]
```
New modules FFT and Inverse FFT

The new modules FFT and Inverse FFT replace the deprecated Fourier Transform module. The FFT module can output module and phase, power spectrum, logarithm of magnitude or power spectrum for easier reading or segmentation, or complex value with real and imaginary components. The results are centered (lowest frequencies at the center).

The module Inverse FFT produces a simple real scalar field instead of a complex scalar field when the result imaginary part is not significant relative to the real part (see module command threshold for details).

Other Image Filters enhancements and changes

Several image filter modules have also been superseded by new modules for improved performance or extended features: Median, Gaussian, Unsharp Masking, Erosion, Dilation, Opening and Closing. Note that image filters are no longer available as editors.

Enhanced Generate Surface

Depending on smoothing type, a Border port option Fit To Edges can prevent smoothing along volume edges for keeping sharp surface edges.
A new port Smooth Material is available for smoothing a specific material, in particular for smoothing contours incident to other materials.

Performance is dramatically improved by multi-core processing.

**Colormap port changes, New colormaps**

The colormap ports are now set by default to local range mode and auto-adjust mode.

![Colormap Settings](image)

**Note**

For project compatibility you may need to disable the global option *Auto-adjust range of colormaps* in the Project menu before loading a project. Otherwise the colormap ranges may be modified and visualization changed compared to previous version of Avizo.

![Project Menu](image)

New colormaps have been included in Avizo: red.am, green.am, blue.am, labels256.am, labelsPastel.am.

**New module Tridelity View**
This new module allows supporting Tridelity auto-stereoscopic displays ([www.tridelity.com](http://www.tridelity.com)). It is accessed from top menu View > Stereoscopic Display.

### NEW FILE FORMATS SUPPORTED

**New reader for Xradia TXM format**

A new reader has been added for Xradia 3D X-ray microscopes file format. Note: this file format is only supported on Windows XP/Vista/7/8.

**New reader for POS atom probe format**

A new reader has been added for POS atom probe binary data format, including 3D points and associated mass/charge value.

**New format formats for surfaces: Avizo Binary, Open Inventor binary/compressed**

Avizo now supports a new binary format for surfaces, compliant with other Avizo amiramesh-style native formats. This is now used by default.

Surfaces can now be exported to Open Inventor format as ascii or binary, compressed or not.

### PERFORMANCE IMPROVEMENTS

**Generate Surface**

The module General Surface is now parallelized, resulting in dramatic performance improvement when using multi-core processing.

### SCRIPTING ENHANCEMENTS AND NEW COMMANDS

**moduleApply**

The new convenience command `moduleApply` is provided as an advanced Tcl example (share/resources/helpers) that can greatly help scripting: it creates a module, sets module ports, and applies the module at once in a single statement. For example:

```tcl
moduleApply HxOrthoSlice data "foam.am" sliceOrientation 2
moduleApply gaussianfilter inputImage "foam.am"
```

This command can usefully replace the deprecated Quantification module `exeCommand`.

**setInteractive (Extract Subvolume, Generate Surface)**

A new Tcl commands have been added to disable warning dialogs in processing scripts. For example:

```tcl
"Extract Surface" setInteractive 0
```
moduleExtender

This command can be used to customize modules. It associates a Tcl procedure with an existing module type. That procedure is called whenever the specified module type is created by the Tcl command `create`, in a project files and with object popup. For example, once the following command is entered, the next Ortho Slice modules created will use XZ orientation (port value '1') instead of the default XY orientation:

```
moduleExtender -name myOrtho -extends "HxOrthoSlice" -proc { $this sliceOrientation setValue 1 }
```
AVIZO FIRE EDITION - ENHANCEMENTS AND NEW FEATURES

See also above in this document the improvements and new features common to all Avizo Editions.

NEW PLATFORMS

Avizo Fire available on Window, Mac OS and Linux

Avizo Fire is now available for operating systems Mac OS X 10.8 (64-bit) and Red Had Enterprise Linux 6 (64-bit, gcc 4.4.x), in addition to Windows XP/Vista/7/8.

Note: for using the Non-Local Means filter or the Anisotropic Diffusion filter in GPU mode on MacOS, you will need to install the CUDA 5.0 drivers.

NEW AND ENHANCED FEATURES

Quantification module replaced by new modules and components

The former Quantification module is now deprecated and has been replaced by a large set of Avizo native modules and components. This major change was achieved to facilitate learning, to improve ease of use and workflows with better user interface consistency, and to enable availability on Mac OS and Linux platforms.

The Quantification module and its associated Result Viewer are still supported by scripts and projects for compatibility with the previous versions of Avizo Fire. The Quantification module is no longer exposed in Avizo menus, but it can be created by scripts or by console command (create HxVisilog). This compatibility mode remains applicable only on Windows platform, and still relies on Visilog 6.9 engine and commands.

However it is highly recommended to migrate your existing script and projects to the new available module set, for benefits in performance, features, multi-platform availability and future compatibility.

The new object popup has an integrated search tool that can quickly retrieve modules corresponding to former commands of the Quantification Tools module, or other different legacy names.

For helping migration of custom Tcl scripts, see the new command moduleApply in section below Scripting enhancements and new commands.

A few features are still exclusively supported on Windows through the legacy Quantification module: the Porosity Analysis Wizard module, the Split Connected Component module, and a number of Visilog commands restricted to 2D or specific usage, or deprecated. Cross-platform support will be extended in future Avizo releases. Would you miss any feature, please contact the Avizo technical support.

Avizo 8 uses the updated Visilog 7.1 image processing engine.
Many new modules have been introduced to supersede commands of the Quantification module:

- **Image Processing**: extended image filters, extensive morphological tools, shading correction, etc.
- **Image Segmentation**: top-hat, marker-based watershed, separation, automatic thresholding, etc.
- **Image Analysis**: individual label analysis, global image analysis, extensive morphometrics, etc.

Here are some properties common to different modules:

- **Interpretation** port for choosing 3D or slice-by-slice processing, when applicable. This corresponds to the Interpretation port of the former Quantification module, while it has been extended to more modules.

- **Neighborhood** port for choosing connectivity processing by face, edge or corner, when applicable. This replaces the former Quantification:neighborhood command.

- **Out-of-core processing.** A number of modules can take as input Visilog .im6 files loaded as "on-disk" external data. This enables processing data without loading it fully in memory, as this was possible with the Quantification module in previous Avizo versions. In most cases then, data slabs are loaded, processed and saved in turn. This allows processing of data that is much larger than the available memory on your system, at the expense of processing time.

By default, a module using "on-disk" input will ask for a filename for saving its result on disk. You may enable a port for choosing memory or disk output with the following Tcl command:

```
<module-name> outputLocation show
```

For convenience, the modules supporting out-of-core processing can now also take as input .lda files (Large Data Access format for streamed loading, out-of-core visualization and quick subvolume extraction). However the .im6 format is still preferred for best out-of-core processing performance.

---

**Enhanced module Interactive Thresholding**

The former Interactive Thresholding module (*HxDspThreshold*) is replaced by a new one with the following enhancements:

- It is now a consistent compute module
- A fast preview can be displayed in 2D or 3D
- A unique range port is used for minimum and maximum thresholds.
New module Interactive Top-Hat

A new module is available for interactive Top-Hat, used commonly for image segmentation of small local features. This module works as a two-steps wizard: first define the closing/opening operation used to isolate small local dark or bright features of given size, then threshold the features contrast depth.

New Segmentation Editor tool: Top-Hat

The Top-Hat operation is now also available as a Segmentation Editor tool.
New modules Global Analysis and Label Analysis

The new modules Global Analysis and Label Analysis are available for quantitative analysis of binary or label images (former Quantification commands *global_analyze* and *l_analyze*). These modules allow selecting or defining a group of measures to be applied globally to a binary image or individually for each label in a label image.

The measures group selection dialog is used to add or remove from the measure group either predefined measures, or user-defined measures.

The measure editor can be used to define new custom measures, entering formulas supporting an extensive syntax that is checked and validated on the fly.
Some measures have configurable attributes.

When applied, the analysis modules create new analysis data objects (specialized spreadsheet type *HxLabelAnalysis*), that are automatically displayed in the Tables Panel.

**New Analysis Result Viewer**

A new component is available for displaying global or individual analysis results, within the dockable Tables Panel. A statistics summary is displayed at the top of the viewer. On top of it a toolbar allows to copy data to clipboard, export data, sort rows, plot the results column selected in the bottom panel, and pick a row to track location of a particular label. Like the former Result Viewer, you can select a row to highlight corresponding 3D location or pick a 3D location to retrieve a measure. Results can be plot as histograms for individual measures, or as profiles per slice for global measures (using Interpretation XY in Global Analysis and curve setting in Plot Tool).
New module Analysis Filter

The new Analysis Filter module creates a new analysis and a corresponding label field, based on a filter expression using one or more measures. Selecting a measure in the measures list shows the corresponding histogram and adds the measure name in the expression. In the histogram plot, you can drag the vertical marker line then double-click on it to copy the corresponding value in the expression.
New module Sieve Analysis

The new Sieve Analysis module classifies labels in input image according to the defined sieve, i.e. groups the labels by measure value ranges, and produces a label image corresponding to the defined classes. In the plot area you can drag marker lines or middle-click to add a marker line. Pressing the detect button will distribute the ranges evenly.

New module Analysis To Spreadsheet

The new module Analysis To Spreadsheet converts an analysis table resulting from Label Analysis or Global Analysis into a generic spreadsheet data object.

New module Volume Fraction

This module computes the volume fraction (porosity) of materials or phases in a binary or label image, with an optional mask defining the reference volume. This module outputs a spreadsheet with one row per label, or per label and per slice, giving absolute volumes, voxel counts and volume fractions. This module replaces the following Quantification commands: image_volume, object_image_ratio, -object_volume, volume and volume3d.

New image processing features

A number of new image processing and analysis features come with Avizo Fire 8, including:
• New Disk and ball morphological kernels in morphological operation modules

• New Image Gradient with extended features
• Extended Gaussian Filter
• New Flow Inpainting filter

Original image, mask and image filtered by Flow Inpainting:

• New Local Orientation module
• New Curvature module

New module Split Connected Components

The new module Split Connected Components extracts from the input image a set of subvolumes surrounding the largest connected components. You can specify the number of components, the segmentation thresholds, and optional masking of exterior or extraneous components. This module creates a new image data object for each extracted subvolume.  

Note: This module is currently available only on Windows.

NEW FILE FORMATS SUPPORTED

Reader for ANU NetCDF subset format
Avizo Fire can import the NetCDF subset format used for simple 3D volume tomography data, originating from the Department of Applied Mathematics and Supercomputer Facility of Australian National University.

Note: for NetCDF files used in climate, atmospheric and oceanic sciences, see Avizo Green Edition.

**PERFORMANCE IMPROVEMENTS**

Performance has been improved in many places in Avizo Fire 8.

**Overall performance improvements**

Thanks to the new Avizo Fire architecture, performance is substantially improved in general for processing labels and 16-bit grayscale images.

**Watershed new implementation**

The watershed algorithm has been redesigned and parallelized, with dramatically improved performance and reduced memory requirements. This applies to:

- The module Marker-Based Watershed (former commands fastwatershed and catchbasin),
- The Watershed tool in the Segmentation Editor,
- The modules Separate Objects and H-Extrema Watershed (formerly binseparate and greyseparate commands).

The related modules can use two of modes:

- Fast - default mode with aggressive acceleration that can produce slightly different yet still valid results when run multiple times
- Repeatable - produces the same result when run multiple times

**More performance improvements**

Other substantial performance improvements have been introduced, for instance in:

- Image Gradient module (former Quantification: gradient commands),
- Gradient calculation in the Watershed tool of the Segmentation Editor
- Non-Local Means filter
- Labeling module (former Quantification: label),
- Gaussian Filter

**AVIZO WIND EDITION – ENHANCEMENTS AND NEW FEATURES**

See also above in this document the improvements and new features common to all Avizo Editions.

**Updated and improved readers**

Support has been updated and improved for the following formats:

- ABAQUS Version 6.12
- ANSYS Version 14.5
- CGNS data base Version 3.1
- LS-DYNA Version 970.0
- EnSight 6 and Gold Casefile format
• FIDAP 7.6
• FLUENT Version 12.1
• MSC.NASTRAN 2010
• OpenFOAM, version 2.0
• IDEAS NX Series 11
• STAR-CCM+ 2.06
• Tecplot file format, version 11.2

AVIZO XSCREEN - ENHANCEMENTS

Support for VRPN

VRPN (Virtual Reality Peripheral Network) is an open source library to connect tracking and input devices to applications. Avizo now can be interfaced with all devices supporting this standard.

Support for Animation Producer

Animations designed with Animation Producer can now be played on advanced multi-display configurations using Avizo XScreen.

AVIZO XPAND – UPDATE

End of support for Microsoft Visual Studio 2008

Avizo XPand now supports Microsoft Visual Studio 2010.
### LIST OF SOLVED ISSUES

The following section presents the main solved issues since Avizo 7.1.1.

<table>
<thead>
<tr>
<th>Issue#</th>
<th>Title</th>
<th>Release notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1331</td>
<td>Generate Lego Surface: input transform was not set in result</td>
<td>Fixed.</td>
</tr>
<tr>
<td>1646</td>
<td>Segmentation Editor: magic wand range reset to default values when reopening the editor</td>
<td>Fixed. The magic wand range is now persistent across invocations of the segmentation editor.</td>
</tr>
<tr>
<td>2141</td>
<td>Volume Rendering an Isosurface Render issues on some Intel integrated graphics chipset</td>
<td>Rendering is now correct on Intel graphics such as Intel HD3000, using updated drivers.</td>
</tr>
<tr>
<td>2268</td>
<td>Plot Tool: can’t change the size of the legend</td>
<td>It is now possible to change the legend font and size.</td>
</tr>
<tr>
<td>2601</td>
<td>Quantification:binseparate failed on large volume</td>
<td>This issue is solved with the new module Separate Object. Note that performance and memory consumption for modules relying on watershed algorithm have been dramatically improved.</td>
</tr>
<tr>
<td>2631</td>
<td>Open Inventor Scene To Surface (IvToSurface): failed converting data</td>
<td>Fixed. That occurred in some case when using &quot;create connectivity&quot; option.</td>
</tr>
<tr>
<td>2782</td>
<td>Calculus MATLAB module: version check gives wrong information</td>
<td>An obsolete warning about MATLAB version was fixed.</td>
</tr>
<tr>
<td>3175</td>
<td>File selections in the Avizo file browser don’t update the Windows Explorer folders history</td>
<td>Avizo now uses the standard file selection dialog of the operating system: on Windows you can access the directory history in the left pane of the file dialog, in Recent places, below Favorites.</td>
</tr>
<tr>
<td>3229</td>
<td>Volume Rendering artifacts compared to previous version</td>
<td>Due to volume rendering engine enhancements, in some case it may be necessary to adjust Volume Rendering Settings or the LDA Preferences in order to achieve the same rendering results as previous versions of Avizo.</td>
</tr>
<tr>
<td>3506</td>
<td>Crash when loading a CATIA VS file</td>
<td>This issue has been fixed and CATIA reader has been upgraded.</td>
</tr>
<tr>
<td>3619</td>
<td>Movie Maker generates MPEG files that can’t play correctly in Windows Media Player</td>
<td>Fixed.</td>
</tr>
<tr>
<td>3759</td>
<td>Integral Mean Curvature is not available in label analysis</td>
<td>Integral Mean Curvature has been added to individual measures (see Label Analysis module).</td>
</tr>
<tr>
<td>3916</td>
<td>Quantification:label command creates several contiguous labels instead of one</td>
<td>Fixed. Note: the command label is replaced by the module Labeling.</td>
</tr>
<tr>
<td>3984</td>
<td>Avizo Wind: failed loading some ANSYS files</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4066</td>
<td>&quot;File not found&quot; message when loading large stack of images files via Open Data dialog (Windows XP)</td>
<td>A restriction of Windows XP file dialogs can prevent to load an image stack made of a large number of separate files because of the total number of characters. As a workaround, one should move and/or rename the files to be loaded through the &quot;Open Data&quot; menu. Alternatively, it is also possible to use Tcl command in the console such as : load -dicom [glob X:/long-path/long-filename*.dcm]</td>
</tr>
<tr>
<td>4212</td>
<td>Non-Local Means Filter fails for large data in CPU mode</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4220</td>
<td>Non-Local Means filter performance decrease when adding a second graphics board.</td>
<td>Fixed. Performance improvements have been achieved for Non-Local Means filter that impacted this case. Note also that updated graphics drivers are recommended for using Non-Local Means filter.</td>
</tr>
<tr>
<td>4272</td>
<td>Volume Rendering, Isosurface Rendering: crash could occur when rendering datasets with very large slice dimensions</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4469</td>
<td>Bilateral Filter applied on 8-bit data changes</td>
<td>Fixed. The following image filters have been modified.</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
<td>Fix</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>4470</td>
<td>XLab Hydro crashed in some case with large data at output creation</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4476</td>
<td>Watershed Segmentation fails for 2D image</td>
<td>Fixed. It is now possible to use Watershed Segmentation module with a 2D image.</td>
</tr>
<tr>
<td>4480</td>
<td>Surface Editor: menu Surface &gt; Edit &gt; Smooth faces has no effect</td>
<td>Fixed. Data was actually modified but the display was not updated.</td>
</tr>
<tr>
<td>4517</td>
<td>Tecplot file imported as incorrect unstructured mesh</td>
<td>The issue was due to degenerate tetrahedra stored as hexahedra in the input file. This is now supported.</td>
</tr>
<tr>
<td>4526</td>
<td>Compose Vector Field with 3 inputs applied 3 times with auto-refresh enabled</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4547</td>
<td>Large 16-bits label files saved as RLE (default) cannot be reloaded</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4552</td>
<td>Interactive Thresholding: in some case using a mask results in incorrect rendering and failure</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4580</td>
<td>Fail to load TIFF image stack, image file incorrectly interpreted as DICOM file</td>
<td>Fixed. Some TIFF file header tag could be interpreted as a DICOM signature and prevent loading completely an image stack.</td>
</tr>
<tr>
<td>4592</td>
<td>Applying some image filter on data larger than 4GB may fail</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4603</td>
<td>Tecplot file imported as incorrect unstructured mesh</td>
<td>The issue was due to degenerate tetrahedra stored as hexahedra in the input file. This is now supported.</td>
</tr>
<tr>
<td>4628</td>
<td>Compose Vector Field with 3 inputs applied 3 times with auto-refresh enabled</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4639</td>
<td>Saving large data as Avizo ZIP format produces corrupted files</td>
<td>Fixed. Data of arbitrary size can now be saved with ZIP compression.</td>
</tr>
<tr>
<td>4658</td>
<td>Extract Subvolume: dragger box sometimes disappears</td>
<td>Fixed. This happened when shadows were enabled.</td>
</tr>
<tr>
<td>4667</td>
<td>Generate Surface does not preserve sharp edges or flat surfaces on volume boundaries</td>
<td>Fixed. A new option &quot;Fit To Edges&quot; is now available to prevent beveling of edges and contours on volume boundaries.</td>
</tr>
<tr>
<td>4683</td>
<td>Movie Maker: stereo side by side outputs in MPEG format don't play in Windows Media Player</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4684</td>
<td>Movie Maker: stereo side by side outputs AVI/DV Video Encoder format don't play in VLC</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4685</td>
<td>Movie Maker: stereo side by side outputs of in AVI/DV Video Encoder format haven't the requested size</td>
<td>Fixed. Note that when exporting with DV Video encoder the output may be stretched because of limitations of the DV Video format.</td>
</tr>
<tr>
<td>4686</td>
<td>Movie Maker: stereo side by side outputs in AVI/MJPEG format don't play in VLC and fail to open in Windows Media Player</td>
<td>Fixed. Note that Windows Media Player may not play MJPEG movies with width larger than 2048.</td>
</tr>
<tr>
<td>4725</td>
<td>Segmentation Editor: issue with watershed tool - empty display and error message</td>
<td>This could occur in &quot;markers&quot; mode when a single marker was defined. A warning dialog now reminds to define at least two markers.</td>
</tr>
<tr>
<td>4736</td>
<td>Auto Skeleton: failed with large data</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4754</td>
<td>Failed loading some DICOM file on Window 32-bit</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4761</td>
<td>Some NetCDF file is incorrectly imported on Windows 64</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4764</td>
<td>Failed saving a project with Histogram module</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4780</td>
<td>Merge: returns a grayscale image instead of expected label/binary image</td>
<td>Fixed. When all inputs are label images, the result of the Merge module is now a label image. The ‘blend’ option is disabled in this case.</td>
</tr>
<tr>
<td>4784</td>
<td>Histogram: plot visibility not saved in project</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4789</td>
<td>Extract Subvolume: memory not freed when removing extracted subvolume</td>
<td>Fixed. Memory was not freed until module was removed.</td>
</tr>
<tr>
<td>4801</td>
<td>Volume Edit: incorrect cut of outer slices with cylinder tool</td>
<td>Fixed.</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td>Fix</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-----</td>
</tr>
<tr>
<td>4803</td>
<td>1-bit PNG files cannot be imported</td>
<td>PNG files with 1-bit encoding are now read.</td>
</tr>
<tr>
<td>4810</td>
<td>Fourier Transform module crashed on 3D binary label</td>
<td>FFT module replacing Fourier Transform cannot be attached any longer from a label image. For using FFT, label images should be first converted to grayscale using Convert Image Type.</td>
</tr>
<tr>
<td>4814</td>
<td>Saving large data (3GB) as Avizo ascii format does not work</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4823</td>
<td>Histogram plot: cannot enlarge the x axis and zoom as expected</td>
<td>The X-axis range of the plot window associated with an Histogram is now synchronized with the histogram range. When Histogram module is in auto-refresh mode, modifying the X-axis range within the plot window will automatically recompute the histogram. For convenience, panning and zooming have been disabled on the Y axis and are only available on the X axis.</td>
</tr>
<tr>
<td>4825</td>
<td>Surface Area Volume module outputs negative volume values</td>
<td>Volume values may be negative when a material's boundary surface is not closed. The boundary closedness is now indicated for each material in the spreadsheet result of Surface Area Volume.</td>
</tr>
<tr>
<td>4838</td>
<td>Camera Path: unexpected camera jump at keyframes</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4909</td>
<td>Register Images: crash when pressing the stop button</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4923</td>
<td>Leica Image Format reader: incomplete dataset names extracted by the lif reader</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4928</td>
<td>Align Slices: reloading project fails if Reference port is connected to an object with alignment transforms</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4933</td>
<td>Movie Maker, Animation Producer: &quot;&quot; no handled correctly in output file paths</td>
<td>Fixed.</td>
</tr>
<tr>
<td>4945</td>
<td>Volume Rendering: does not update upon changing color, when using constant color option</td>
<td>Fixed. Note that 'Constant color' now appears directly at the end of the colormap list in the colormap menu, instead of Options submenu.</td>
</tr>
<tr>
<td>4955</td>
<td>Segmentation Editor - magic wand tool: &quot;Same material only&quot; option is not working as expected when &quot;Fill interior&quot; option is enabled</td>
<td>Fixed. Now &quot;Same material only&quot; has priority over &quot;Fill interior&quot;: when this option is set the voxels belonging to the same material as the seed location are never selected by the magic wand tool.</td>
</tr>
<tr>
<td>4967</td>
<td>Shading Correction Wizard: normalization factor cannot be changed</td>
<td>Fixed. A new port Normalization Factor has been added.</td>
</tr>
<tr>
<td>4991</td>
<td>Segmentation Editor: minor issues</td>
<td>It is now possible to use F2 to rename a material. The slice number in 2D views is now also indicated starting from 1, for instance: &quot;#0 (1/128)&quot;.</td>
</tr>
<tr>
<td>5024</td>
<td>Segmentation Editor: abnormal selection-wrap interpolation</td>
<td>Fixed. In particular the accuracy of the wrapping tool has been improved for thin selections.</td>
</tr>
<tr>
<td>5025</td>
<td>Surface View / Tetra Grid View: Draw tool in Buffer port works only in the first viewer</td>
<td>Fixed. It is now possible use draw tool lasso selection in any viewer.</td>
</tr>
<tr>
<td>5062</td>
<td>CSV read as Uniform Scalar Field: invalid Tcl load command in data parameters</td>
<td>Fixed.</td>
</tr>
<tr>
<td>5074</td>
<td>Segmentation Editor could crash when closing after the Material Statistics dialog was closed</td>
<td>Fixed.</td>
</tr>
<tr>
<td>5156</td>
<td>Tcl commands &quot;app availableMemory&quot; / &quot;app totalMemory&quot; return incorrect values</td>
<td>Fixed.</td>
</tr>
</tbody>
</table>